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Chapter 1 to Chapter 7.14 are common steps that need to be performed for both, basic and 
advanced analysis.  

Chapter 1: Datasets 
Unless otherwise specified, all steps in the walkthrough will refer to the dCODE Dextramer® (RiO) and 
AbSeq training Dataset. 
 

Dataset 1: SRiO BD Rhapsody file 
Assays: Rhapsody targeted, AbSeq, dCODE Dextramer® (RiO) - Human 
Description: ~3,000 sorted CD8+ dCODE Dextramer® (RiO) -PE+ cells. Contains 1 sample. 
Rhapsody files: N709_DBEC_MolsPerCell.csv 
SeqGeq files: 3k_RiO_AbSeq_DBEC_v0.geqzip 

 

Chapter 2: Software requirements 
 

SeqGeq 

RiO BD Rhapsody workflow requires SeqGeq V1.6 or later versions. SeqGeq is available as a desktop 

application and helps you extract insight from the individuality of single-cell gene expression. The software 

is available here (https://www.flowjo.com/solutions/seqgeq/downloads), together with full Seq-Geq 

Documentation (https://docs.flowjo.com/seqgeq/).  

 

 

Chapter 3: Loading files into SeqGeq 
 
Loading data in SeqGeq is as easy as dragging and dropping you expression matrix file (currently .csv, .txt, 

.tsv, .mtx, .tab, and .h5 formats are supported) into the SeqGeq workspace . You can also browse for data 

that you wish to load directly into the application by clicking the “Add Samples” button within the Analyze 

tab at the top of the workspace: 

 

 

1. Drag N709_DBEC_MolsPerCell.csv file into the sample pane. Alternatively, click Add Samples. 
 

         
 

Once the data have been added to the workspace you will see the file name in the status area of the 
workspace and in the Samples pane.  

 

https://www.flowjo.com/solutions/seqgeq/downloads
https://docs.flowjo.com/seqgeq/
https://docs.flowjo.com/seqgeq/
https://docs.flowjo.com/seqgeq/


 

 

 

Chapter 4: Normalization 
 

Purpose: To improve comparability between cells. Normalizing based on total molecules in each cell for a 
given set of genes is a common approach.  
 
Normalization can be done by accessing the Normalization button within the Analyze tab. 
 

1. Click on the Normalization button:  

 
 
 
 

2. The normalization dialog window will appear. Choose counts per 10,0000 

 
 

 
Performing normalization will generate a new icon meant (generically) to indicate that an adjustment has 

been applied, moving (or reshaping) data: 

 

 
 
 
 
 
 



 
 
 

Chapter 5: Generate Gene set Lists  
 

Gene set lists are helpful for directing specific analyses. For example, you may wish to observe how AbSeq 

(protein-associated) genes drive differences in your data set without the contribution of mRNA expression. 

It is also useful to analyze complex single-cell sequencing data sets in the absence of genes that do not display 

low levels of variance, as it is highly unlikely that these genes drive meaningful differences within the data. 

This section will focus on the creation of gene set lists that will facilitate noise reduction and enhance 

discovery.    

 

We will first create a list that focuses on mRNA related UMIs (non-antibody associated genes).  

 

1. Go to the Genes tab in the workspace and select New Static Gene Set. In the Static Gene Set Editor 

name the list. Then select and add only the mRNA-associated parameters. Save the list. A new list 

will be created in the workspace within the Genelist pane (top). The list will appear with its name and 

the number of genes contained within it (e.g. “my mRNA, 397”). 

 

 
  



2. Create a gene set that contains only the AbSeq´s parameters.  Hint: you can filter antibody genes by 

typing “(Ab)” in the Genes box of the Gene List Editor.  

 

2.1 Click under the Genes tab, select the New Static Gene Set option. 

 
 

2.2 Name the GeneSet “AbSeq” and type (ab) under genes to select only the AbSeq´s to create the 

list. The GeneSet is visible on the upper pane. 

 

  
 

3. Create a gene set that contains only the RiO reagents  

4. Create a gene set that contains only the putative positive dCODE Dextramer® RiO specificities 

5. Create a gene set for the RiO neg. ctrls (A full list of RiO Reagents and specificities is located at the 

end of the document).  

 

This process will facilitate the selection of pertinent parameters to create bivariate plots, heat maps 

and other analyses. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



Chapter 6: Quality control 
 

Purpose: This step removes cells and/or genes that may contribute potential noise (e.g. dead or dying cells, 

housekeeping or cell cycle genes); if the number of putative cells is suspected to be erroneously high, this 

action can be performed to remove “cells” that may not represent true cells.  

 

1. Select the sample in the bottom panel (in this example, N709_DBEC_MolsPerCell.csv). In the 

Analyze tab, within the Discovery band, select Quality Control. 

 
 

 

2. This will generate three plots, one in cell view and another two in gene view:  
2a. Cell view: Genes expressed vs library size (total number of molecules in each cell) 
2b. Gene view: Cells expressing vs total reads (UMIs) 

2c. Gene view: Dispersion (normalized variance for each gene) vs cells expressing (mRNA levels) 

 

To have a better visualization of the graph adjust the axis by clicking on the T icon (Transform axis) and select 

Log-Shift Axis.  

 

 
 



Note: You can adjust the resolution of the Graph window display in the options tab under the graph. Select 

the desired resolution by clicking on the drop-down menu and highlight the resolution of your choosing. 

 

 
 
To further refine the cell population being analyzed, it is beneficial to rank the cells based on the number of 

mRNA UMIs per cell and remove the highest and lowest ranked cells (presumed doublets and dying cells, 

respectively). For this dataset it is beneficial to focus on the mRNA UMIs as some cells might bind 

nonspecifically RiO reagents and account for a big proportion of reads mimicking a real cell but having a low 

number of genes expressed.  

 

By default, in the Cell View graph with X-axis = library_size and Y-axis = genes_expressed, SeqGeq will 

consider all of the parameters measured indistinguishably from genes, AbSeq or RiO reagents. 

 
 

1.  Go to genes_expressed vs. library_size generated graph, and copy it to the layout editor by going to 

the Edit tab and selecting Copy to Layout Editor.  

 

Note: The first graph copied will automatically open the Layout editor and this can be renamed 01 – QC. The 

subsequent graph should be re-ordered in the editor.  
 

 
 
 
 

2. Create a plot to gate for high quality cells by focusing only on the mRNA UMIs: go to the 

genes_expressed vs. library_size plot and create a “Knee Calling” plot: 

o 2a. Click on the Y-Axis side wing, select the mRNA list and Apply the Sum operation. 

o 2b.  Adjust X-axis to Rank 

o 2c.  Click on T for Y-axis – change scale to log-shift 

 



 
 

See the Seq-Geq_quality-control section for more details. The Dead and Debris regions are not seen in Knee- 

Calling plots because the data are pre-filtered and have selected putative living cells. 

 

Use one of these options to draw a gate to remove the highest and lowest ranked cells (presumed doublets 

and dying cells, respectively):  

 

• Rectangle gate (2nd button from left) 

• Elliptical gate (4th button from left) 

• Polygon gate (5th button from left) 

• Freeform gate – pencil (6th button from left) 

• Autogating (7th button from left) 

 

Autogating will probably pick up the majority of relevant cells. 

 

 
 

http://docs.flowjo.com/seqgeq/flowjo-seqgeq-documentation/quality-control


 
3. Name gate as desired (e.g. “QC cells”). 

The gate will appear as a subset of the original sample in the bottom pane: 

 
 

4. Copy the plot to the layout editor. 

 

5. In the “Cell view” plot, choose genes_expressed (Y-axis, from the Y-side wing) and mRNA SUM (X-

Axis). Keep the scale linear on both axes.  

 
6. Copy the plot to the layout editor. Drag the QC-cells subpopulation from the workspace and drop it 

on the copied graphs (genes_expressed vs. library size/mRNA (Sum)) within the layout editor. Below 

it can be beneficial to focus on the mRNA to filter out cells not fitting in the distribution. 

 

 
 
 

Chapter 7: Manual Gating  
 

Purpose: Use known cell surface markers to identify and separate different cell subsets.  

 
Go to the Layout editor and create a new layout by clicking on the + icon. Rename it 02- Manual Gating. 

 

Gating the CD8+ and RiO specific T cells  

 

1. Double click on the QC_cells population and on a Cell view plot Click on the X-axis side wing bar to 

access the parameters. 

2. Select marker of interest on the X-axis (CD19 AbSeq)  

3. Click on the Y-axis side wing to expand it. 

4. Select marker of interest on the Y-axis (CD14 AbSeq) 

 



 
 

5. Draw a gate around the CD14+CD19-, CD14-CD19+ and CD14-CD19- to filter out the non CD8 T cells 

using one of the buttons at the top and name it.  

 

 
 

Note: To tint the new gates, tick the tint box under the active gate section. Assign the desired color. The new 

gates will show up under the parental population.  

 
6. Copy the manually-gated graph to the Layout Editor by clicking on the graph and using Ctrl+L shortcut, 

or right click on the graph and select “Copy to Layout Editor”. To hide gates from the plots in the 

Layout Editor, double click your plot, go to the Annotate tab, and unclick “Show Gates” if desired. 

 
7. The populations will appear under the parental population. 

 

 
 
 



8. To manually gate on the CD8+ T cells for each of the RiO specificity, the usage of a negative control 

can aid to set the noise-to-signal threshold. To generate a threshold plot, open a Cell view plot under 

the CD19-CD14- population and select the CD8 AbSeq (Y-axis) and on the X-axis plot (Sum) of the RiO 

negative controls. This plot shows the non antigen specific interactions  to CD8+ T cells.  

 

 
 

9. To aid setting the threshold and to better visualize the entirety of the distribution, click on the T 

button and select customize axis next to the  X-axis parameter selector. 

 

 
 

10. Increase the maximum range by several decades and click in the  button. The new 

graph will have a larger range on the X-axis. 

 

 
 

11. Create a gate on CD8+ expressing, RiO bound cells. 

1. Set the positive gate’s Y- axis bound on CD8 AbSeq expression. 

2. Set the postivie gate’s X- axis bound using the   RiO negative control distribution (i.e. 300 

molecules). Assume the threshold value be greater than 300  molecules.  



 

  
 

12. Copy the graph to the Layout editor. 

 

13. Continue to gate for each RiO focusing on the cells that are CD8+ and exceeding the 300 molecules 

threshold for RiO signal.  

 
14. Hint: You can use the expression level for each RiO as a guide for gating. To do this, tick the “Color  

Axis” box in the Graph Window and select the corresponding RiO to guage expression.  

 
 

15. Copy each graph and arrange it in the layout editor. Gating these populations will result in the 

following flow in Layout editor.  

 

Note: for an advanced visualization setting you can  include histograms. Right click on the graph 

in the layout editor and select “Adjunct Histograms” 

 
Notice that each RiO Reagent should be assessed individually. For example, RiO_5016 shows a 

trimodal distribution. Three gates where generated: one for high expression and two for the 

intermediate distributions (one above the noise threshold and the other below). Gating each of the 

populations might help to interpret the results. 



 
 

16. Each gated population will appear under the CD19-CD14- parental population. 

 

At this point, your analysis is complete. If you wish to apply unbiased analysis, please proceed with the 

following steps.                   



To represent the data using other visualizations, you can use the violin box plot plugin. You will 
need to concatenate and export the RiO populations in a new workspace (information on “how to 
concatenate” are available here).  Use the sample ID to gate back on each single population and 
then run the Violin Box plugin.  

Unbiased analysis  
 

Chapter 8: Installing plugins 
 

For this analysis, you will need 1) the R statistical computing and graphics software (https://www.r-

project.org/) and 2) the following plugins listed below.   

 

 R Installation 

 

1. Navigate to www.r-project.org 

2. Download the appropriate R version for your operating system. 

3. Install the R software on your computer’s hard drive.  

 

 Set the R Path 

 

Once R is installed on your computer, it will need to be linked to SeqGeq by directing it to the location of 

installation. 

1. Open FlowJo and click on the preferences icon , then click on the Diagnostics icon , in this 

window choose the correct location of R installation. 

For Windows the path is usually:   

 

For Mac, the path is usually:  

 

 

2. Then click ok to close the preferences window. SeqGeq is now connected to R and will be able to execute 

plugins. Download the plugins listed below and copy/paste the .jar file into the plugin folder.  

 

R-package installation 

 

Some plugins require additional packages to be downloaded and installed using R. Consult with the plugin 

“How-To” documentation to install those packages.  

 

 

SeqGeq Plugin download and installation 

 

1. Navigate to exchange.flowjo.com. 

2. Download the following plugins: 

 

 

https://docs.flowjo.com/flowjo/workspaces-and-samples/samples-and-file-types/ws-export/
https://www.r-project.org/
https://www.r-project.org/
http://www.r-project.org/


 

3. Phenograph (v 3.0) 

Phenograph is a clustering method designed to partition high-dimensional single-cell data into 

phenotypically distinct subpopulations. It works by creating a graph (“network”) representing 

phenotypic similarities between cells and then identifying communities in this graph. Requires 

R. Download link: https://www.flowjo.com/exchange/#/plugin/profile?id=1 

4. ViolinBox (v 5.1) 
Violin and box plots are popular ways of illustrating expression patterns between genes or 

proteins of interest and across different populations or samples. Download link: 

https://www.flowjo.com/exchange/#/plugin/profile?id=13 

5. UMAP (v 3.1) 

UMAP is a machine learning algorithm used for dimensionality reduction to visualize high 

parameter datasets in a twodimensional space. Download link: 

https://www.flowjo.com/exchange/#/plugin/profile?id=6 

6. iCellR (v 1.1.1.) 

The iCellR plugin allows users to perform: clustering (from the nbClust R package), tSNE, 

UMAP, and PCA analyses - simultaniously - and view the results in an interactive 3D plot using 

GoogleChrome. In SeqGeq, there is additional functionality to perform Differential Expression 

Analysis on a categorical clustering parameter based on an unsupervised clustering algorithm, 

or SampleID, at the click of a button.  Download link: 

https://www.flowjo.com/exchange/#/plugin/profile?id=34 

7. Lex  

This plugin allows to automatically De-Multiplex Compound Single-Cell data into Seq-Geq. Lex 

converts annotations from multiplexed data files into appropriately named populations 

within the Seq-Geq workspace.  Download link: 

https://www.flowjo.com/exchange/#/plugin/profile?id=3 

 

 Set the SeqGeq plugins folder 

 

You will need to connect SeqGeq to the plugin files by setting the plugin folder path in SeqGeq.  

1. Unzip the downloaded plugins from the section above. 

2. Copy the .JAR file of each plugin. 

3. Paste the .JAR file into the SeqGeq plugins folder. (On Macs this is usually /Applications/SeqGeq 

plugins. On PCs this is usually C:/Program files/SeqGeq/plugins. 

4. Open SeqGeq. 

5. Click the preferences button (heart icon). 

6. Click the “Diagnostics” button. 

7. In the Miscellaneous section, tick the box that reads “Scan for plugins”. 

8. Click the “Choose” button to select the file path to the plugins folder or type the path in the box 

adjacent.  

 
9. Click Ok and exit from preferences.  

10. Restart SeqGeq. 

11. Check that SeqGeq has access to the plugins by clicking the Workspace tab, populations band, plugins 

drop-down menu. You should see a list of plugins if the path was set correctly.  

https://www.flowjo.com/exchange/#/plugin/profile?id=1


 

 

Chapter 9: Selecting highly dispersed genes for dimensionality reduction plots 
 

Purpose: Identify genes that will result in the best possible separation of populations in dimension- 

reduced space. We will isolate parameters with the highest variance/ dispersion. 

 
1) Open a graph window and click “Gene View”.  

2) Change the Y- axis to dispersion and the X-axis to cells_expressing. Adjust the scale to log-shift if 

necessary. 

  
 

 
3) Draw a gate to select highly dispersed genes by going to Graph -> Manual Gate. (Your current window 

must be on the plots to see this toolbar pop up). For example, choose genes expressed in at least 10 

cells with dispersion of 1.5. 

  
 

4) Gene sets from gates will appear in the workspace within the top pane: 

 

 



 

Chapter 10: Dimension Reduction  
 

Purpose: To reduce the number of dimensions (genes/parameters) such that the relationships between cells 

can be visualized in two dimensions. This approach is generally used to visualize high dimensional datasets 

and understand the quantity and phenotypic differences that exist in a given data set.  

 
Select the QC_cells and go to Analyze -> Dimensionality Reduction (Discovery tab). 

 
 

Part 1: Principal Component Analysis (PCA)  

 

Purpose: To reduce the number of dimensions of high-dimensional data (e.g. single-cell RNA sequencing) in 

order to simplify visualization and interpretation. Principal component analysis will identify genes or groups 

of genes that have high variance and drive differences between populations of cells.  

 

Note: It is beneficial to perform PCA  before t-SNE, UMAP, TriMAP or other non-linear dimension reduction 

techniques.  

 

1) In the Dimensionality Reduction window, select PCA as the method and choose genes to run PCA on 

using “Select Genes”. 

 
 
Note: You may wish to select genes of interest as follows: 



 Unbiased: Use original sample with all genes. 

 Targeted: AbSeq. Select AbSeq only genes (see next step for how to select a subset of genes) 

 Targeted: mRNA. Select mRNA only genes. 

 Targeted: Highly Dispersed genes. Select the highly dispersed gene set. 

 
For this dataset we will select the “HDP” list that contain all the highly dispersed parameters measured. 

 

1) Click to the HDP list and “Add All”.  

 
 

 
2) Keep initialization as deterministic (same results every time) and # of principal components as 25. 

Then hit “Run”. 

 
 

3) Select the number of principal components 

a. The Default is 6. 

b. Ideally you will want to pick where cumulative % variance begins to plateau (in this case 15). 



 
 

 
4) A PCA plot is generated.  

a. In the Layout editor, create a new layout by clicking in the + and rename it 03- DimRedux. 

b. Send the PCA plot DimRedux to the Layout Editor by clicking on graph and using Ctrl+L 

shortcut, or right click on graph and select “Copy to Layout Editor”. 

 
 

c. On the layout editor right click the generated PCA and select – Make Multigraph Overlays – 

NxN Plots. This shows you all the principal components calculated. Note that the variance 

reaches a plateau in the lower graphs. 

 



 

 
 

Part 2: t-Distributed Stochastic Neighbor Embedding (t-SNE) 

 

Purpose: tSNE provides a visualization of all PCA parameters in a single 2D plot 

 
1) Select the same sample. Open up the Dimensionality Reduction window. Select tSNE as the method. 

Then Click “Select Genes”.  

 

 
 

2) Then select the Parameters radio button at the top of the menu. Type in “PCA” under Genes to find 

all the principal components. Select all the PCA parameters, then click Add Selected. Finally, click 

Select in the bottom right of the dialog. 



 
 

3) Use Auto (opt-SNE) for Learning Configuration. Make sure Learning Rate is at least 7% of the number 

of cells. Then click “Run”. 

 

 
 

4) A tSNE plot is generated.  

 

5) Send the plot to the DimRedux layout in the Layout Editor 



 
 

6) If you wish to open this plot again further on, double click your sample (“QC_cells” in this example) 

to open the plot window.  

Note: You may need to adjust the axes to tSNE coordinates. Click each axis, select +tSNE, then 
select tSNE_Run_1 for the X-axis and tSNE_Run_2 for the Y-axis. 

 
 
  



Part 3: Visualization of manually gated sub-populations on a tSNE map 
 

Sub-populations can be visualized using the manually created gates, or identified by using a number of 

different clustersing algorithms. Here we will compare manual gating with the Phenograph clustering 

algorithm.  

 
1) Duplicate the t-SNE in the layout editor. 

2) Click and drag the subpopulations from your annotation to your tSNE plot in the Layout Editor. 

 

 

 
 

Note: If desired, remove the original sample from the list of annotations (last row of annotation table). 

Right click and select “Remove layer”. For each layer the color can be changed by clicking on the color 

box. Also, each layer can be re-ordered by selecting in placing it up or down on the layer hierarchy. The 

top is the most frontward. 

   



 
3) To add additional statistics like “Frequency of total” (calculates % of each annotated subgroup out of the 

entire sample), right click any row and select “Properties”. 

4) Under “Add Column”, select “Freq. of Total”.  

Optional: Click “Save” to retain these statistics as a default one when generating annotations. 

 

Part 4: Using the Phenograph clustering algorithm to automatically identify subpopulations  
 

PhenoGraph is a clustering method designed to partition high-dimensional single-cell data into 

phenotypically distinct subpopulations. It works by creating a graph (“network”) representing phenotypic 

similarities between cells and then identifying communities in this graph.  

 
1)   Select the population to be analyzed. For this example, QC_cells. 

2) Click the plug-ins icon under the workspace tab, and select PhenoGraph from the drop-down list.  

 

  
 

3) Select the parameters to be used. For this example, we will use the PCA´s generated.  
The k number of nearest-neighbor is adjusted by default to 80 (check the “How to PhenoGraph.pdf” 
document downloaded with the plug-in for more details). 
 

https://www.flowjo.com/exchange/#/plugin/profile?id=1


 
 
4) Once executed, the algorithm will create a new parameter capturing the PhenoGraph cluster ID along 

with gates dissecting the input population (sample) into distinct subpopulations (e.g. 
“Phenograph_H14I_1”). In addition, PhenoGraph will display the resulting modularity. Modularity is 
a value between -1 and 1 that is used as a score for the quality of the graph partitioning (check the 
“How to PhenoGraph.pdf” document downloaded with the plug-in for more details). 
 

 
 

5) To have a tidy workspace it is possible to create a gate on all of the PhenoGraph populations displayed 

on the graph using the Range tool. A new population will be generated where you can select all the 

derived PhenoGraph populations and drop them to make this the parental population that you can 

deploy to ease the usage of the workspace.   

  
 

6) After dropping the populations, the non deployable can be deleted. 

 

 



Visualize PhenoGraph populations on the tSNE map and benchmark them with the subpopulations defined 

by manual gating. 

 
1) In the layout “04 – Clustering” copy the tSNE graph from the Dimredux layout by right-clicking on 

the tSNE plot and select Copy Selection with Transparency or by the shortcut key (Ctrl+C/Ctrl+V) 

  
 

2) Select the generated PhenoGraph subpopulations and overlay them on the tSNE plot. 

 

        Here you can visually inspect how well PhenoGraph has clustered the populations generated by tSNE. 

 
 



 

Chapter 10: Expression patterns 
 

Part 1: ViolinBox 
 

Purpose: Violin, box and whisker plots, and heatmaps are all popular ways of illustrating expression patterns 

between populations, genes, or proteins of interest. The plots available in this plugin include a ‘half violin’, 

jittered data points, and a standard set of the boxplot and violins. The plugin also offers a heatmap function, 

Spearman correlation plots and some simple statistical tests. 

 
1) Select the PhenoGraph parental population. 

  
2) Under the plugins tab within the workspace, select ViolinBox.  

 
3) A parameter selector window will appear. Choose the parameters to include in the violin plots. The 

selected parameters will appear later once the interactive Shiny application opens in your web 

browser. For this example, select all the AbSeq and RiO reagents. There is also an option to select a 

“categorical parameter” such as a clustering parameter. For this example, we will select the 

PhenoGraph derived parameter. Chose “Interactive” to visualize the ViolinBox output. 

 
 

 
 

4) The interactive Shiny application will open in your web browser. 



 
 

  
5) Please read the “How To ViolinBox.pdf” downloaded with the plug-in to learn how to navigate the 

Shinny app. Briefly, on the data tab is possible to select the different parameters (AbSeq and RiO) 

and Phenogrpah clusters that want to be visualized as Heatmap, Raincloud or correlation plots.  

 

 
 
 
  



Part 2: Differential expression using iCellR 
 

For this example, we will look for the differentially expressed parameters from the PhenoGraph populations. 

By identifying the differentially expressed genes, it is possible to identify new markers that will help us to 

define these sub-populations. 

 
1. Select the PhenoGraph parental population. 

 

2. Select iCellR after clicking on the plug-ins icon under the workspace tab. 

  
 
 
3. Select all the parameters or those you want to be assessed. For this example, Select all the genes, 

Abseq´s and positive RiO reagents. 

 



dCODE 
Barcode: Specificity MHC allele/peptide Catalog # 

5006 Negative Control A0101_SLEGGGLGY_NC   

5007 Negative Control A0201_ALIAPVHAV_NC   

5008 Negative Control A2402_AYSSAGASI_NC   

5009 Negative Control B0702_GPAESAAGL_NC   

5010 Negative Control NR_AAKGRGAAL_NC   

5011 FLU WB2161-A0201/GILGFVFTL    

5013 EBV WB2130-A02/GLCTLVAML    

5014 EBV WB3529-A02/FLYALALLL    

5015 CMV WB2132-A0201/NLVPMVATV    

5016 CMV WB2658-A0201/ VLEETSVML    

5017 EBV WK2146-B35/EPLPQGQLTAY   

5018 EBV WK2145-B35/HPVGEADYFEY    

5019 CMV WK2138-B35/IPSINVHHY   

AbSeq pool:   Clone Catalog # 

CD4 CD4 SK3 940001 

CD8 CD8A RPA-T8 940003 

CD14 CD14 MPHIP9 940005 

CD19 CD19 SJ25C1 940004 

CD25 IL2RA 2A3 940009 

CD39 ENTPD1 TU66 940073 

CD45RA PTPRC HI100 940011 

CD45RO PTPRC UCHL1 940022 

CD56 NCAM1 NCAM16.2 940007 

CD62L SELL CD62L:DREG-56 940041 

CD69 CD69 FN50 940019 

CD197 CCR7 3D12 940014 

CD279 PDCD1 EH12.1  940015 

CD74 CD74 G46-6 940010 

LAG3 LAG3 T47-530 940080 

Tim3 HAVCR2 7D3 940066 

Sorting pool: specificity Clone Lot: 

CD8 BV421  CD8A     

CD3-PE CD3     
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